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Static maps are included as part of electronic documents, usually PDFs. The maps generally function as images 
which cannot be interacted with by the viewer. To be accessible for a visually impaired reader, the maps must 
be explained by text that can be accessed by other reading technologies. This text can be a description of the 
map message, a data table, a list, a link to more information, or contact information for someone who can 
describe the map. Simple maps can include the data with the map; complex maps may need to point elsewhere. 

All elements should flow together as if it were a text-only document. Imagine the document without the maps, 
with alt-text in its place. Does the map stand alone or does it need more information? Does a good description 
of the map message exist in the surrounding text or elsewhere? Does the order makes sense and does it flow?  

The recommendations are followed by common design scenarios. Find a situation similar to yours, then be 
creative. Applying accessibility varies with software. See the “Software Tips” section for suggestions.  

Recommendations 
• Organize the map’s message by arranging all the elements in a logical reading order.  

o Connect the elements by placing them in order, by referencing, or by linking.  
o A good electronic reading order for comprehension is text first, then the map, then a table. Difficult 

reading order can be touched up after exporting to PDF by moving elements in the tag tree. 
o Don’t repeat. Each element should add unique information and work with the rest.  

• Use captions and alternative text (alt text).  
o Put the detail in body text or captions so it is available for all readers and editors. These are easier to 

edit since word processing features are available like spell check, find/replace, links, indexing, and 
automatic numbering. With this information available, the alt text can be brief. A short alt text can 
indicate the type of map and then reference the more detailed descriptions.  

o If the alt text must stand alone, it must detail the message the map is trying to convey. However, keep in 
mind that alt text is hidden from most users and may be forgotten when other updates are made to a 
document. 

• Make repetitive text easier to scan; list the unique information first. For example: 
o Figure 12: Water table elevations, map of Felton Prairie Fen Area, Clay County, Minnesota 
o Figure 13: Pre-mining conditions, map of Felton Prairie Fen Area, Clay County, Minnesota  

• Export maps as images when possible, and insert them into a document program that applies accessibility, 
such as MS Word or InDesign. Note that image files are only pixels, so there is no text available for reading 
technology. Important text such as titles and captions should be typed into the document outside the image. 
Apply accessibility measures such as alt text with the document program.  

• If exporting maps directly to PDF, export flattened (without layers). Check the dialog boxes for options. Then 
apply accessibility with a version of Acrobat Professional. Tag the entire map and legend as a figure, then 
add alt text. Tag captions and titles as text. Tag tables as tables and establish header rows. 

• Tidy up. Remove any elements that clutter the message by tagging them as background, such as decorative 
images. Repetitive items may be able to be described as a group with the first one, and the rest tagged as 
background.  

• Read the final flow. Does it make sense? Could you use the text alone? If you needed more information, 
could you easily find it?   
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Tagging map PDFs with the Acrobat Professional 

This short checklist is for tagging maps in PDFs using Acrobat Pro, XI, DC, 2017, 2018, etc. The exact steps will 
vary with each version.  

Design your maps so the text is outside the map image area so each is easy to select, and export without layers 
(flattened) or items may disappear during tagging.  

Open the tool “Touch Up Reading Order” or “Reading Order,” select an item with the cursor, and tag as follows. 

1. Select the entire map and legend as one unit and tag it as a Figure. 
2. Select the caption or title and tag it as Text (or a heading, depending on your structure). 
3. Add alternate text.  

 

Additional accessibility protocols must be applied to the rest of the document but are not covered in this guide.  
The “Software Tips” section contains a longer checklist on page 10.  

See the state accessibility website listed on the cover page for best practices for map design (Map Design 
Guide),” other types of maps, and making other software accessible.  
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Design scenarios for accessibility 

Include map, description, and data together in the document  

This example is ideal for simple maps. It shows a map with a good title, description, and data table, all following 
each other. Since the necessary descriptions and titles are already present in a proper order, the alt text can 
simply refer to the table: “Map 1. See Table 1, page 6.” 

• This is possible for smaller data sets. For larger tables, link to a table in an appendix, a website, or a 
spreadsheet/CSV file. Ensure that the linked text matches the title.  

• If the table is too large or complex to be useful, give good descriptions of the map message somewhere: in 
the body text, caption, alt text, or a link to more information elsewhere. Arrange all in a reading order that 
makes sense. See examples on the following pages. 
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Provide descriptive text near the map 

When the data table cannot be included, describe what the map is trying to convey in the body text or a caption 
that immediately precedes or follows the map. Then the alt text can simply refer to the figure number and type 
of map. How much detail you put in the alt text depends on how much other information is provided around it.  

 

Provide alt text that directs the reader to data or a list.  

Example 1: “Map of Minnesota DNR regions. Addresses on following page.”  

 

Example 2: “Minnesota Map of county health care choices. See list on following page.” 
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Link from the map to more information 

Provide alt text that directs to a hyperlinked list:  
“Map of libraries in the arrowhead region. Links to libraries on following page.”  

 

Provide a link in the document to a navigable website with descriptive text and addresses.

 

Provide hyperlinks or references between documents. 

• Jump to or reference within a document: from the text description to a map on another page (and back).  

• Jump to or reference another document with a link. If the target document is long, the text of the link 
should include the specific page and/or figure number.  
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Provide a human contact 

A human is the best accessibility tool. Provide contact information, put it up front in the reading order where it 
is easy to find, and make sure that your staff is prepared to take calls for the life of the map. Assistance may 
involve providing the maps in an alternative format, or merely guiding a caller through the map contents. Decide 
whether providing an alternative format or a human being would be more effective. See your agency for your 
departmental policy.  

Resources 
WCAG Tutorials:  

• Complex images  

4 Syllables: 

• Writing text alternatives for maps 

• Text alternatives for images with captions 

https://www.w3.org/WAI/tutorials/images/complex/
https://www.w3.org/WAI/tutorials/images/complex/
http://4syllables.com.au/articles/text-alternatives-maps/
http://4syllables.com.au/articles/text-alternatives-images-captions/
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Software Tips 
The following are some notes and tips gathered on software commonly used to create maps.  

Creating maps and exporting 

GIS Software 

Most maps are created from a GIS program like ArcMap then exported to other formats such as PDF or JPG. GIS 
software currently will not produce PDFs tagged for accessibility, so this will have to be done in other software 
such as MS Word, InDesign, or Acrobat Pro. These export settings for ArcMap may make the process easier.  

Export to PDF and tag in Acrobat. Select settings for the purpose of your document.  

• Decide what you really need. Try for the simplest PDF. Additional attributes can clutter up tags and add to 
the file size. Check that your files aren’t too large for practical downloading. 

• Export PDFs flattened. Layers can disappear when applying accessibility to the exported PDF.  
In ArcMap: Options > Advanced > None.  

• Note: applying accessibility in Acrobat can remove georeferencing. 

• Export to an image file, place in a document application, and apply accessibility. Here are things to consider: 
o Exporting to an image file will tag easily but may pixelate, depending on the chosen resolution. 
o Exporting to a vector file may be crisper but also may bring in messy attributes. 

Adobe Illustrator 

GIS maps can be exported to Adobe Illustrator and refined for publication. In Illustrator, the export to PDF has 
many export options. The following are a few suggestions. 

File > Save As > PDF: select settings for the purpose of your document. 

• The comments about GIS exports above also apply to Illustrator.  

• Flatten your art when possible. Layers increase file size and sometimes disappear when accessibility features 
are applied in Acrobat. Decide if they are needed for your purposes. 

• “Optimize for fast web view” reduces file size by compressing text and line art with no loss in quality.  

• Deselect “Preserve Illustrator Capabilities" unless you want others to be able to modify your PDF. It 
increases file size. 

• Color and Grayscale Bitmap images: stay at 300 dpi or above for quality purposes 

• Color conversion: Converting from CMYK to RGB is okay. The reverse is not recommended. 
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Inserting maps in document programs 

Microsoft Word 

MS Word is a document program that receives maps as images, and has accessibility functions built in to 
produce a tagged PDF. Inserting images eliminates the extra attributes that come in from exports to PDF from 
ArcMap or Illustrator. Using MS Word allows more flexibility with editing, and allows you to apply the 
accessibility and save it. The drawback is that you can’t control the image quality or the scale.  

Procedure: 

• Export maps as image files, insert into MS Word as inline pictures, and add alt text.  

• Keep the title and caption out of the image so it can be edited and tagged with MS Word. 

• Apply accessibility to the rest of the document elements.  

• You can check for issues within MS Word before exporting to PDF. Final tweaking will need to be completed 
in the PDF with Acrobat. See the state accessibility site listed on the cover page for more information.  

Adobe InDesign 

InDesign is an advanced layout application that receives finished map documents and has advanced accessibility 
functions. It is made for long documents and mixed layouts (text and graphics) and professional publication to 
print, web, or e-documents. Map files are linked, so work can continue on maps and the InDesign file 
simultaneously. Accessibility is applied within the program and saved before export to PDF.  

Image procedures and recommendations: add alt text to each image: right-click > Object Export Options. 

• If done individually, use Custom, Based on Object, and fill in the alt text.  

• If there is already metadata with the image, use From Structure and choose the option that contains the alt 
text. Alt text can be added at any time to the images. You can also set up an object style to do this 
automatically as the images are placed in the document.  

• Flatten linked images when possible. This guards your image from being divided up or elements 
disappearing. 

• Ensure all your links are updated. 

• Apply all the other accessibility functions to the text, tables, reading order (articles and layers panel), and 
metadata. 

• Export the InDesign file to PDF and complete the accessibility process.  

• Save as Type:  
o Print setting: select Create Tagged PDF, as well as Bookmarks and Hyperlinks. 
o Interactive setting: changes color space to RGB. Later versions (2017) will do everything, including 

setting the Display Title and Language. 

• The export dialog box will tell you if there are any issues to go back and fix.  

• Open in Acrobat and run the accessibility checker. Fix any issues in InDesign, re-export and repeat.  
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Tagging an exported PDF 

This is a general checklist is for tagging an PDFs for accessibility using Acrobat Pro, XI, DC, 2017, 2018, etc.  
The exact steps will vary with each version. This list is only a general reminder. For more details see the state 
accessibility website resources listed on the cover page.  

1. Export without layers without layers (flattened). Look for advanced options when exporting. 

2. Design the page so the map and text can be selected separately. 

3. In the Accessibility tools, open Touch Up Reading Order or Reading Order. 

4. Select the entire map with the cursor and tag it as a Figure. 

5. Select the text (figure title or caption) and tag it as text (or headers if you choose). 

6. Add alternative text to figures. 

7. Tag items you want ignored as Background. 

8. Close the Accessibility tool. 

Continue to apply the remainder of the nonmap accessibility functions. 

9. Tag text as text or headers if needed. 

10. Give tables headers if needed. 

11. Create links if needed. 

12. Fill in properties (metadata), File > Properties: Title, Author, Subject, Keywords. 

13. Change to Document title in the Initial view tab. 

14. Change the language to English in the Advanced tab. 

15. Set the tab order. 

16. Run a full accessibility check and fix the issues. See state PDF guides for assistance.  

Other Notes: 

• Acrobat Professional is necessary for exporting with tags and applying accessibility. Acrobat Reader does not 
have the capability.  

• There are options to reduce the file size after exporting: File > Save As Other > Optimize PDF). You choose 
the settings.  

• Multiple files can be assembled into a PDF with later versions of Acrobat tools: (File > Create). Multiple files 
from different programs can all be done in one step. This is preferable so the tags will be in proper order. 
Assembling PDF pages manually causes the tags for the new pages to go to the end.  

For problems and troubleshooting for PDFs in general, consult a more detailed PDF guide. 
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Troubleshooting 

Each software handles accessibility differently and versions are changing rapidly. This list includes best practices 
that can be applied generally and can help make the best choices. 

Export to an image 
• Exporting maps to an image file (jpg, png, tiff, gif, etc.) is the smoothest option, but the raster (bitmap) 

image output may suffer quality and pixelate.  

• Vector images have better resolution but may bring in extra attributes that could present problems with 
tagging for accessibility. 

• Image files must be placed in a program like MS Word or InDesign to add alt text.  

• If the entire image is converted to a PDF page and you cannot grab it to tag it, try running an Optical 
Character Recognition in the PDF. You could also convert it to an image from Acrobat. 

• Recommendation for JPG settings: choose color model RGB, with at least quality 8 and text optimized, 
import into PDF, tag and add alt text. This can compromise the quality of some elements, so check 
resolution. 

• Remember to keep the title and caption text out of the figure or it won’t be read. 

Export directly to PDF and apply accessibility with Acrobat 

You may want to do this when the resolution or scale is not satisfactory with an image, or other features are 
needed. Unfortunately, unwanted attributes can come with it and cause difficulty with accessibility.  

• Flatten your map layers before exporting. This will prevent items from disappearing when you apply 
accessibility in Acrobat. This applies to multi-layered files from programs like ArcMap, Illustrator, and 
Photoshop. Note that this may remove attributes from some applications like MaPublisher. 

• Do not include layers when possible (see export options dialog boxes). If you must and there is a problem, 
check the problem item in your layers in the Edit PDF tool and try to rearrange the layers. 

• Check ArcMap export. Choose resolution according to your end product. The option for optimized text 
should give the best clarity.  

• If items become transparent after tagging, make sure the document doesn’t have any overprints. If you have 
checked for overprints and it is still happening, try ungrouping the items and export again.  

• When possible, embed fonts or use common fonts that are resident on most computer systems.  
Unique fonts may generate accessibility errors for some people, and for future software. 

Printing 

• When printing from a PDF, you may sometimes see blocky shapes you did not create. If you can’t fix the 
source file, you can fix the outcome in the PDF print dialog box: Advanced > Print as image.  
You may have to tell your recipients to do this, or put instructions on the website. The problem is on the 
receiving end, and may happen on some printers and not on others. It is a printer software/ driver issue.  

• You could also try exporting your PDF to an earlier version that does not support transparency:  
PDF X1a, Acrobat 4. 
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